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Part I : Logging on and Good Password Practices 
Logging on: 

 Press the three buttons: CTRL-ALT-DELETE at the same time. 

 Enter your USERNAME and PASSWORD into the window that appears.  

 

Good Password Practices: password must be changed every 60 days. Your password must: 

be between 6 and 8 characters in length (inclusive) 

be easy to remember 

Not be your first name, surname or login. 

Not be a single real word e.g. book. 

Not be "qwerty" or something similar, as it is amongst a hacker's favorite first attempts. 

 

Good Password Examples: 

• tac0snax : 8 characters, no real words, but easy to remember. 

• P@ssw0rd: use numbers or special characters instead of letters in words, ("&","!","#"). 

• 1000$0Kor easily remembered keyboard patterns instead of words. 
 

Part II : Introduction to the Desktop 
 Desktop Customizations 

1. Screen resolution. 

2. Gadgets: To add gadgets to the Windows 7 desktop, follow these steps: 

Step 1. Right-click anywhere on the desktop and choose Gadgets. 

Step 2. Drag and drop the gadget from the menu to the desktop, or double-click the gadget to 

add it to the desktop, or right-click the 

gadget and choose Add. 

 

3. Personalize: In the Personalization 

window, you can change the desktop 

appearance, display setting, and sound 

settings. 

 

Windows 7 Personalization window  
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Task: 

- Write down the Screen resolution for your computer. 

- Show two of the Gadgets available on your computer. 

- Change the background, screen saver, and window colors on your computer. 

 

 Working with Icons : My Documents, My Computer, The Recycle Bin 

 

 Arranging Icons on the Desktop:  

Task: Arrange icons on the desktop using one of the following: 

a. by name  b. by size  c. by type  d. When last modified. 

 

 Changing the Icon: 

Right click on the icon PROPERTIESSHORTCUT tabCHANGE ICON 

 

 Changing the size of the icons: 

Click and hold down the Ctrl key and then use your scroll wheel on your mouse to resize the 

icons 

 

 Shortcuts:  

To create shortcut: Right mouse click on an empty part of the desktopNEW 

SHORTCUT 

 

Task: Create a folder with your name on C drive, then change the icon, and create a shortcut on 

desktop. 

 

 Desktop features: 

 Shake - Minimize all windows that are not being used by clicking and holding the title bar 

of one window and shaking it with the mouse. Repeat the action to maximize all of the 

windows. 

 Peek - View the desktop icons that are behind open windows by placing your cursor over 

the Show desktop button found at the right edge of the taskbar. This makes the open 

windows transparent. Click the button to minimize all windows. 

 Snap - Resize a window by dragging it to one of the edges of the screen. Dragging the 

window to the left edge of the desktop fits the window to the left half of the screen. 

Dragging the window to the right edge of the desktop fits the window to the right half of 

the screen. Dragging the window to the top of the screen will maximize the window. 
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Part III : The Taskbar and Start Menu 

 Customize the taskbar 

Task: Fill in the blanks:  

1. To unlock the taskbar: _____________________________ 

2. To move the taskbar: _____________________________ 

 

 Pinned applications: 

To add an application to the taskbar (or start menu) for easy access, right-click the icon of an 

application and select Pin to taskbar (Pin to start menu). 

 

 Help and Support 

START buttonHELP AND SUPPORT (You can also hit F1) 

 

 Arrange windows 

To arrange windows automatically: right-click an empty area of the taskbar and then choose 

cascaded, stacked, or side by side. 

 
 

Part IV : Task Manager 

The Task Manager allows you to view all applications that are running and to close any 

application. To open the Task Manager, press CTRL-ALT-DEL and select Start Task 

Manager. 

Alternatively, you can open the Task Manager by right-clicking the taskbar and selecting Task 

Manager  
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Part I : Control Panel 

 

 
 

 What software versions do I have and what is on my computer? 

Right mouse click on MY COMPUTER icon  PROPERTIES  

 

Task: open the properties on your computer and find out the software version. 
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Part II : Windows Libraries 

 When Windows is installed, each user has four default libraries: Documents, Music, Pictures, 

and Videos.  

A library presents content from different 

locations in the same folder. You can search a 

library, and you can filter the content using 

criteria such as filename, file type, or date 

modified. 

To create a new library, open a folder and 

select Libraries > New library. 

To customize a library, right-click the library 

and click Properties. The Properties window 

allows you to add folders to the library by 

clicking Include a folder. You can also change 

the icon for the library and customize how items are arranged. 

 

Part III : Folders and File Management 
 
 

 Change thumbnail size and file details 
 

 Selecting Files and Folders: 

1. Single Selection: and click once 

2. Scattered Selection: Use  CTRL key . 

3. Block Selection: Use SHIFT key . 

4. Selecting All: Use CTRL+A. 
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Part IV : Files Name, extension and Path 
 File Extensions: 

.doc , .docx : Microsoft Word files 

.xls : Microsoft Excel files 

.pdf : Adobe Acrobat files 

.ppt : Microsoft PowerPoint files 

.JPG, .Bmp: Image File 

.Mp3: Audio File 

 File Paths:  

 

 Renaming Files and Folders 

Right click on the file or folderRename (or press F2) 

 

 Deleting Files and Folders 

Temporary Deletion: Right-click the file or folder, and then click Delete. 

Permanent Deletion: SHIFT + delete. 

 

 Restoring Deleted Files 

Right click on the file or folderRestore 

 

 Folder and File Attributes 

Right click on the file or folderSelect Properties 
 

Part V : Shutting Down or Logging off a Computer 

 Log Off: Means that you log off as a User without turning the computer off. Someone else 

can then log on.  

 Shut Down: Means that you log off as a User and the computer is turned off at the same 

time. You will lose any unsaved information's. 

 Restarting your Computer: Restarting your computer means that the computer logs you 

off to system, turns itself off and turns itself back on again so you can re-log on 

 Sleep – Documents, applications, and the state of the operating system are saved in RAM. 

This allows the computer to power on quickly, but uses power to retain the information in 

RAM. 

 Hibernate – Documents, applications, and the state of the operating system are saved to a 

temporary file on the hard drive. With this option, the computer takes a little longer to power 

on than the Sleep state, but does not use any power to retain the information on the hard 

drive. 
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Comprehensive Task: 

1.  Create a folder named (collection) on the C drive 

2.  Create two subfolders inside the above folder, with names (images) and (data) 

3. Open Microsoft word then insert some objects [clipart, table, pictures, and 

paragraphs] on it then save it in the subfolder (data) 

4. Open Microsoft excel then insert some data then save the file in the subfolder (data) 

5. Open Microsoft PowerPoint then insert some shapes or pictures then save  

the file in the subfolder (data) 

6. Delete the word file, where did it go? Can you restore it? Where was it 

restored? 

7. Search your computer for pictures of type (jpg), choose 3 of the search 

results then save them on the folder (images). 

8.  Open the picture in paint program [using open with option] then save it in 

other formats: gif, bmp and png. 

9. View the files in the subfolder (images) in details view then arrange the files 

according to size in descending order. 

10. View the files in the subfolder (data) in list view then arrange the files 

according to name 

11. Find the size of the folder (collection), then compress it [using WinZip or 

WinRAR] and check the size again. What do you notice? 

12. Change the icon shape for the folder (collection). 

13. Create a shortcut for the folder (collection) on the desktop. 
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Part I : Introduction to Word 2010 Environment 
. 

 
 

Part II : The Quick Access Toolbar 

You can add other commands to make it more convenient for you 

Task: Add the following commands: Quick Print and Save as to Quick Access Toolbar 

Task: Delete the above commands from Quick Access Toolbar 

 

Part III : Creating new file 

Task: 

using templates, Create 2 new files: one contains a design for a certificate, and another  one 

contains brochure 

Task: create a blank file. 
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Part IV : Home Tab 

Clipboard Group 

Task Use the blank file you’ve created in the above task to do the following: 

- Select a paragraph from the skills PDF book then copy it. 

- Paste the copied paragraph on your file. 

- Select a word inside the pasted paragraph, and then move it to a new line. 

- Format a word inside the paragraph [Hint: use the group font], and then copy the format 

to another word. 
 

Font Group 

Task 

- Write (Balqaa Applied University) in Arial font, of size 16. 

- Try the bold, italic and underline commands on the above sentence. 

- Write the following: H2O and 25
o
C using superscript and subscript. 

- Try strikethrough, text effects, highlight and font color on words from the paragraph in 

the previous task. 

- Write (bALqAa aPPLiEd uNIvERsiTy), then try the cases from change case on it. 

 

 

Paragraph Group 

Task 

- Write an English paragraph about your country where you live (at least 3 lines), make 

sure that the direction is left to right and the alignment is left before start; put a border 

around special word(s) in the paragraph. 

- Write an Arabic paragraph about your specialty (at least 3 lines), make sure that the 

direction is right to left and the alignment is right before start, color (shading) a special 

word(s) in the paragraph. 

- Justify both paragraphs. 

- Make the line spacing 1.5 for the English paragraph and 1.15 for the Arabic paragraph. 

- Write a bulleted list for 3 countries then add some of their famous cities (multilevel list). 

- Write a numeric list for your everyday activities (multilevel list). 
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Task 

 direction isأسطر تتحدث فيها عن بلدك الذي تعيش فيه تأكد من اتجاه الكتابة ) 3اكتب فقرة انجليزية لا تقل عن  -

left to right( والمحاذاة )alignment is left( ًقبل البدء بالكتابة، ضع حدودا )borders حول كلمة مميزة في )

 .1.5( = line spacing، اجعل تباعد الاسطر )الفقرة

 direction isأسطر تتحدث فيها عن تخصصك الذي تدرسه تأكد من اتجاه الكتابة ) 3أكتب فقرة عربية لا تقل عن  -

right to left( والمحاذاة )alignment is right( قبل البدء بالكتابة، اضف لون )shading خلف  كلمة مميزة في )

 .2.0=  (line spacing، اجعل تباعد الاسطر )ةالفقر

 ( كلاً من الفقرتين السابقتين.justifyاضبط ) -

( ثلاث من البلدان التي تود زيارتها، مع ذكر بعض من مدنها الرئيسية )استخدم bulleted listاذكر بتعداد نقطي ) -

increase indent.) 

 (.increase indent( اعمالك اليومية، مع ذكر بعض الاعمال الفرعية )استخدم numeric listاذكر بتعداد رقمي ) -

Styles Group 

Task 

- Try Elegant Style or  Formal Style for your document. 

Editing Group 

Task 

- Find a word in your document. 

- Replace a word by another one. 

 

Comprehensive Task 
 

Open Microsoft word, type the following data: 

 

Today is Sunday 16/10/2016, this is AUTUMN. The temperature is 21oC, the weather is fine. 

This is lab. We will take 2 exams as the following:  

1. Mid Exam: 
o Windows  

o Word  
2. Final Exam: 

i. Excel  

ii. PowerPoint  

iii. Internet  
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Part I : Insert Tab Groups 

Pages Group 

Task Copy a paragraph from Skills Book on a blank page, then do the following: 

- Insert a cover page (صفحة غلاف) for the document. 

- Insert a blank page (صفحة فارغة) after the cover page. 

- Insert a page break (فاصل صفحات ) inside the paragraph in the 3
rd

 page. 

 

Tables Group 

Task 

- Insert a table (3 cols )اعمدة(   & 2 rows )صفوف(  ), then fill it with data. 

- Notice the two additional tabs that appeared: 

o Design Tab: Color some cells (shading), Add new borders (Try to draw diagonal 

borders), Delete some borders, Use styles group to get more professional designs. 

o Layout Tab: Add/Delete rows and cols, merge/split cells, split table, align text in 

cells and check text direction within the cells. 

Task 

- Write the following data: 

First,Second,Third 

A,B,C,D 

11,23,14 

- Select the above text then click on tables  Convert text to columns. 

- In separate text at option choose comma then click ok. 

 

Illustrations Group 

Task 

- Insert a picture (صورة), from the Design Tab appeared: Remove Background, add frame, 

move the picture (using wrap text) and crop the picture. 

- Insert a ClipArt (صورة كاريكاتورية), from the Design Tab appeared: Add frame, move the 

clipart (using wrap text), rotate the clipart and crop the picture. 

- Insert a Shape (شكل), from the Design Tab appeared: Change the style (Fill, Outline and 

effects). Add Text inside the shape (change text direction), rotate the shape and change 

the shape to another one. 

- Insert a SmartArt (رسم ذكي) (e.g. Water cycle) from the following Tabs appeared:  

o Design Tab: Change: Layout, Colors and Styles. 
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o Format Tab: Change the Shape Style and WordArt Style (Fill, Outline and 

effects)... 

- Insert a Screenshot from Skills book, and a Screen Clipping from the desktop. 

 

Header & Footer Group 

Task 

- Insert a header (رأس الصفحة) that includes: your name, date and time. 

- Insert a footer (تذييل الصفحة)  that includes page number and a picture,  

 

Text Group 

Task 

- Insert a text box (صندوق نص) contains the word (Skills), from Format tab change: shape 

& text (Fill, outline and format), text direction and change the shape. 

- Insert a WordArt (كتابة فنية) contains the word (Balqaa Applied University), from Format 

tab change: shape & text (Fill, outline and format), text direction and change the shape. 

 

Symbols Group 

Task 

- Write area of the circle. 

- Insert the following equations: 
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Comprehensive Task 

 وقم بعمل الاتي: Wordافتح برمجية 

 اكتب اسمك وتخصصك وكليتك -

 ادرج الجدول الاتي: -

C B A 
L 

N 

C1 B1 

A
1

2
 1 

BC2 2 

C3 AB3 3 

 

 .(Blank Page) بالبيانات النتاسبة قم ادرج صفحة فارغة(  واملأه Cover Page)ادرج  -

 نجمه يحتوي اسمك واختر لون وتأثيرات ملائمة. (Shape)ٍ شكلادرج  -

 وضع اطار ملائم. (Picture) ادرج صورة -

 وقم بتدويره لليمين.(ClipArt) ادرج -

 للجامعة المكونه من كليات واقسام.(SmartArt) ادرج -

 لجزء من سطح المكتب.  (screen clipping) اعمل -

  (: تاريخ اليوم والوقت.headerادرج في ) -

  .(: رقم الصفحة وصورةfooterادرج في ) -

(: ضع فيه تخصصك ثم غير الشكل الى شكل اخر مناسب مع تغيير الالوان textboxادرج ) -

 .والتأثيرات

  (.WordArt) اكتب اقتباس مميز باستخدام -

 توي على: تكامل، اسس، جذر،بسط ومقام.تح (Equation) اكتب معادلة رياضية -
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Part I : Page Layout Tab  

Themes Group 

Task1: Copy a paragraph from Skills Book on a blank page, and then do the following: 

- Apply one of the Built-in themes appeared in Themes command. 

- Customize a new theme by choosing Colors, Fonts and Effects available in the group. 

 

Page Setup Group 

Task2: 

- Change the margins of your document from Normal to Narrow, then to Wide, what do 

you notice? 

- Change the document Orientation in to Landscape (Horizontal Page). 

- Split text in a page into 2 columns, 3 in another page. 

 

Page Background Group 

Task3: 

- Add a Watermark to your document: your name in a diagonal layout. 

- Change the Page Color. 

- Add a Page Border to the document, choose from Style the line layout you want, or 

choose from Art for more options. 

 

Part II : References Tab  

Table of contents Group 

Task4: 

- Choose one of the Built-in Table of Contents appeared in Table of Contents command. 

- Or press on insert Table of Contents from the menu in Table of Contents command. 

 

Footnotes Group 

Task5: 

- Insert a verse from the Qur'an, and then refer to it as a Footnote. 

- Insert a line of poetry, and then refer to the poet and the poem as a Footnote. 

- Insert a quotation, and then put on a Footnote who said it. 

- Copy a paragraph from skills book, and then refer to the book in the Endnote. 
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Part III : Preview Tab  

Proofing Group 

Task6: 

- Press on Spelling & Grammar command, and correct the errors appeared in your 

document: 

o Spelling Errors: underlined with a red wavy line. 

o Grammar Errors: underlined with a green wavy line. 

- Also try the right-click mouse options on errors. 

 

Part IV : Auto correction options   
Task7: 

- Add the word (blqa) to the Auto correct options to be corrected into: Balqaa Applied 

University. 

- Add the word (bal) to the Auto correct options to be corrected into: AL-Balqaa Applied 

University. 

 

Comprehensive Tasks 

 :ما يلي وقم بعمل Wordافتح برمجية  -1

 (.Landscapeل اتجاه الصفحة الى افقي )حو   .1

 في اي موضوع تهتم به. أسطر( 3اكتب فقرة )لا تقل عن  .2

 ادرج صورة مناسبة للموضوع. .3

القرآن الكريم، حديث شريف، بيت من الشعر أو قول مأثور( مع الاشارة اليهما اكتب اقتباسين )من  .4

 .ح الملف من الاخطاء الاملائية والنحوية، ثم صح   (Foot noteبملاحظة اسفل الصفحة )

 (.End noteانسخ فقرة من موقع الكتروني )او كتاب( ثم اشر اليه بملاحظة في نهاية الملف ) .5

( ليتم كتابة nnn( قم بإضافة الرمز )Auto correct optionsح التلقائي )باستخدام خيارات التصحي .6

 اسمك الرباعي تلقائيا.

 ( لصفحات الملف.Water markاكتب اسمك كعلامة مائية ) .7

م الصفحة الى عمودين ) .8  .(Two columnsقس 

 ضع اطارا منقطا حول الصفحات. .9
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 :من حيث التنسيق الاتي ملفلل ملف مشابه وقم بعمل Wordافتح برمجية  -2
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Part I : Introduction to Excel 2010 Environment 

 
 

Task Try the previous right-click options (from 1 to 5) on a new worksheet. 

 
Task Select the following ranges: 

 (1) B2:B9 (Vertical Range)   (2) E2:J2 (Horizontal Range)   (3) D4:F7 (Block Range)  
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Task: Select a cell then enter: 

Ctrl + ; what’s the contents of the cell? 

Ctrl+ : what’s the contents of the cell? 

Using the Fill Handle to Fill Cells 
Task: Apply (1) then (2), try to find out the result of filling cells in (3), (4) and (5). 

 

Task: What will be the contents in the cell A5?  

 

Part II : Home Tab  

Clipboard Group 

 
Task Print the following data: 

- Copy A3 contents to C2. 

- Move contents of C2 to C4 

- In B3 write the formula: =A2+A3. 
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- Copy the result in B3 then paste it on B4. What do you notice? 

- Copy the result in B3 then paste it on B5 using one of the paste options (values). What do 

you notice? 

Font Group 

Task Start typing from A1, the following data: 

 

Name Mark 

Sami 78 

Kareem 81 

Ahmad 92 

Yazan 45 

 

Alignment Group 

Task Add the following changes to the previous task, Notice that: 

Cells A1 & B1 are merged in one cell (by Merge & Center option). 

Cell C2 is formatted by: Wrap Text option. 

Cells A2 & B2 are formatted to aligned in center & middle. 

 
Merge & Center the cells C3:C6 

Write inside the merged cells (Students Results) in 90
o
 orientation text.  

Format the table to 

be as the following: 

http://holowczak.com/getting-started-with-microsoft-visual-studio-2010-using-c-tutorial/


LAB.6 : Excel2010 (Introduction) 

 

Computer Skills Lab                            Page 5                           By: Islah K. Gharaibeh 

 

[Hint: use the command ] 

 
 

Number Group (Format Cells dialog box) 

1- Number Tab 

Write the number 1.9438, use Number Tab in Format cells dialog box: 

Choose Number from Category, then: 

- Let the decimal places = 3, what do you notice? 

- Let the decimal places = 1, what do you notice? 

- Let the decimal places = 0, what do you notice? 

Choose currency from Category, and then choose ($). 

 

2- Alignment Tab : 

 
3- Font Tab 

4- Border Tab 
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5- Fill Tab 

 

Styles Group 

design tab 

 

Cells Group 

 
Insert Rows 

Insert Columns 

Delete Rows 

Delete Columns 
Modify Column Width 

 

Comprehensive Task 

 :من حيث التنسيق الاتي ملفلل ملف مشابه وقم بعمل Excelافتح برمجية 
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Part I : Review 
Task: As you learned in word, using the insert tab, insert the following: 

1- A picture (choose one of the pictures in pictures library اختر اي من الصور الجاهزة في الجهاز). 

2- A clipart (e.g. books). 

3- A star shape شكل نجمة    (Write your name inside it) add some effects اضف بعض التأثيرات    

(outline, shadow, glow … etc.). 

4- A smart art that describes the hierarchy of the university ( هيكلية الجامعة من حيث الكليات والاقسام في

 .(كل منها

5- A screen shot (from desktop or the material الشاشة من المادة او سطح المكتب صورة ). 

6- A text box contains (Excel 2010) than change the shape (غير الشكل الى شكل آخر) and add some 

effects. 

7- A word Art contains your specialty (اسم تخصصك). 

Part II : Insert Tab  

Charts Group 

Task: Using Excel do the following: 

 

 

 

 

 

 Select the table in sheet1, and then insert a column chart for the data. 

 Select again the table in sheet1, then insert a bar chart for the data. 

 Select the f(x) column in sheet2, and then insert a line chart for the data. 

 Select the table in sheet3, and then insert a pie chart for the data. 

Use the following additional tabs that appear after inserting the charts: Design, Format and 

Layout 

 

Text Group 

Task Insert a header & footer: 

In sheet3 

 

Item p 

A 5 

B 25 

C 12 

D 33 

E 25 
 

In sheet1 

 

Name Mark 

Jameel 75 

Sami 35 

Khaled 67 

Osamah 90 

Talal 47 

Ahmad 85  
 

In sheet2 

 

x F(x) 

0 0 

2 4 

5 25 

10 100 
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In header: write your name in the left, “Computer Skills” in the center and insert time in the 

right. 

In footer: insert a picture in the left, “Good Luck” in the center and insert page number in the 

right. 

Part III : Simple Formulas  

Mathematical Operations: 

Task: Write the following data (start from cell A1): 

x y 

5 2 

Then write the following: 

 

 

 

 

 

Errors in Excel: 

#######: The contents of the cell cannot be displayed correctly because the column is too 

narrow. 

#REF! : A cell reference is invalid. This is often displayed when you delete cells that are 

involved in a formula. 

#NAME? : Excel does not recognize text contained within a formula 

Editing cell content: 

Task: Edit the cell below by adding the letter d. 

   
 abc  

   

 

Order of Operations (Priorities): 

1. Operations enclosed in parentheses 

x+y= 
 

x-y= 
 

x*y= 
 

x/y= 
 

x^y= 
 

 

x+y= 7 

x-y= 3 

x*y= 10 

x/y= 2.5 

x^y= 25 
 

Use cell references 

to calculate: 
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2. Exponential calculations (to the power of) 

3. Multiplication and division, from left to right. 

4. Addition and subtraction, from left to right. 

 

Task: Calculate the answer of the following formula [=4*3+18/(5+4)-2^3] 

 

Absolute References 

Task: Use the data in sheet1 you’ve previously created, and do the following: 

 

 

 

 

 

 

Comprehensive Task 

 :لكل من السلع التالية(واحسب السعر الجديد )بعد الضريبة  Excelافتح برمجية 

Hint: New Price = Price + Price * Tax 

Item Price 
New 

Price 

shirt 9.5  

T-Shirt 5.25  

Suit 120.5  

Socks 1.85  

Shoes 16.75  

Belt 4.25  

 
  Tax 0.06   

 

Name Mark 
New 

Mark 

Jameel 75  

Sami 35  

Khaled 67  

Osamah 90  

Talal 47  

Ahmad 85   
 

Bonus 3  
 

Name Mark 
New 

Mark 

Jameel 75  

Sami 35  

Khaled 67  

Osamah 90  

Talal 47  

Ahmad 85   
 

Bonus 3  
 

Use the absolute 
cell reference to 

calculate new mark: 
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Part I : Working with Basic Functions  
A function is a predefined formula that performs calculations using specific values in a 

particular order.  

Excel basic functions:  

 SUM : returns the sum of cells in a range.  

 

Adding cells to the function argument   Result Syntax of a basic function 

 AVERAGE : returns the average of cells in a range.  

 MIN : returns the smallest number in a set of values.  

 MAX : returns the largest value in a set of values.  

 Count: 

Task: Insert the following data: 

 
 

 ة؟يً اتًالخلي،ًماًمحتوً (COUNT(A1:C3)=المعادلةً)ةًفارغةًأكتبًيخل ًًيفً 

 ROUND : Rounds a number to a specified number of digits. ROUND(number,num_digits)  

Task:  
ً،ًثم:(E1)ًةيالخل ًًيً فً(1.70254ًيً)اكتبًالرقمًالتال ً ً

o  ًًةيخل ًًيف(E2)ًًاكتبًالمعادلة(=ROUND(E1,2))ًاتًالخل ًًيً ،ًماًه ًة؟يمحتو 

o  ًًةيخل ًًيف(E3)ًًاكتبًالمعادلة(=ROUND(E1,3))ًاتًالخل ًًيً ،ًماًه ًة؟يمحتو 

o  ًًةيخل ًًيف(E4)ًًاكتبًالمعادلة(=ROUND(E1,1))ًاتًالخل ًًيً ،ًماًه ًة؟يمحتو 

o  ًًةيخل ًًيف(E5)ًًاكتبًالمعادلة(=ROUND(E1,0))ًاتًالخل ًًيً ،ًماًه  ة؟يمحتو 
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 IF : returns one value if a condition is TRUE, and another value if that condition is FALSE  

IF(logical_test, [value_if_true], 

[value_if_false]) 

 

 

 

 

Task: in D2 write the formula 

=IF(C2>=80; C2+3; C2+5), fill 

to cell D7.  

 

 

 

 

 

 

Function Library Group 

 

Part II : Data Tab  
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Sorting data 

 
Task: What name will be inA6 if the sort is ascending? 

 

Custom Sort (sorting multiple levels) 

 
Task: What name will be inA4 if you sort by mark smallest to largest then by name A to Z? 

 

Filter Data 
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Text to Columns 

 

 

Part III : Review Tab (Adding a Comment) 

 
 

Part II : Using Templates  

Excel allows you to create a new workbook using a template, which is a pre-designed 

spreadsheet, To Create a New Workbook Using a Template: click New from the File tab, and 

then click Sample templates to choose a built-in template, or select an Office.com template 

category 
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Comprehensive Task 

 :وأدخل(Excelً)ًةيبرمج افتح

 ي:التال الجدول 

 (.Sumن)الاقترا باستخدام الطلاب علامات مجموع احسب ­

  (.Average)ًالاقتران باستخدام الطلاب علامات معدل احسب ­

  (.Max)ًالاقتران باستخدام للطلاب علامة أعلى احسب ­

  (.Min)ًالاقتران باستخدام للطلاب علامة أدنى احسب ­

ايجد عمودا أضف ­  على تحتوي معادلة ه ً ف واكتب (Result)ًبعنوان د 

بعيًثً حيب(ifً)ًجملة  ، 10 تساوي او اكبر العلامة كانت اذا(.Pass)ًط 
بعي أو  .10 من أقلًالعلامة كانت اذا (Fail)ًط 

 (if)ًجملة على تحتوي معادلة يهف واكتب(New Markً)ًبعنوان ايدً جد عمودا أضف -

معي 11 من اكبر العلامة كانت اذا ثً يبح  او من أقل العلامة كانت اذا أما ،2 ًلها ج 

 .3 ًلها معيجً  11 تساوي .
 
 ي:التال الجدول 

Mark Name 
Rami 58 

Laith 70 

Zaki 44 

Jehad 82 

Zaid 93 

Ahmad 90 

Rayan 44 
 .ا يًتصاعد الطلاب اسماء حسب السابق الجدول رتب ­
ً.ًا يًتنازل الطلاب اسماء حسب السابق الجدول برت ­
 حسب رتب ةً يمتساو العلامات بعض كانتًواذا ا ،يتصاعد الطلاب علامات حسب السابق الجدول رتب ­

ً(.Hint: Use Add Level)ًا يًتنازل الاسم

 .فقط 80­100ًضمن علامات احرزوا نً ذيال الطلاب عرض م كنكي ثً يبح السابق الجدول فلتر ­

 .فقط Zaid الطالب علامات اعرض السابق الفلتر باستخدام ­

ً

Mark Name 
Jamal 9 

Ali 12 

Saleem 5 

Hani 18 

Kamel 11 
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Part I : Introduction to PowerPoint 2010 Environment 

 
 

Task Write your name and your city on the 1
st
 slide (اكتب اسمك واسم مدينتك على الشريحة الاولى). 

 

Part II : Home Tab  

Slides Group 

 .تخطيط الشرائح، وتنظيم الشرائح في أقسامإضافة الشرائح، وتغيير وإعادة تعيين من هذه المجموعة  تمكنك
 

 

Task Add a new slide to your presentation (use: Ctrl+M OR click Home TabSlides ) 
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Task: 

 شرائح ثم اختر تخطيط الشرائح 3قم باضافة  

(Layout) الملائم لكل منها: 
 .(pictureأدرج ) -

 (.clipartأدرج ) -

 أدرج فيديو. -

 لكل منها. عنوان ملائممع وضع 

 

 

Task Insert a picture to the new slide, write a title and write text. 

 
To Change the Layout of an Existing Slide: 

1. Select the slide you wish to change. 

2. Click Home tab  Slides group  Layout.  

3. Choose a layout from the menu. The slide will change 

in the presentation. 

 

Task: 

 شرائح ثم اختر تخطيط الشرائح الملائم لكل منها 3قم باضافة  
أسطر في موضوع معين مع وضع صورة  3اكتب ما لا يقل عن  -

 وعنوان ملائمين.

 مع وضع عنوان ملائم. (pictureو ) (clipartأدرج ) -

  بعنوان فقط.شريحة  -

Part III : Insert Tab  

(، ClipArt(، رسوم )Picture(، صورة )Table( يمكنك ايضا ادراج جدول )Excel( و )Wordكما درست سابقا في )

(، ارتباط تشعبي Chart(، رسم بياني )SmartArt(، رسم ذكي )Shapes(، أشكال )Screenshotsصورة من الشاشة )

(Hyperlinkالخ ... ،) جميع ما سبق ادراج فيديو أو مقطع صوتي للشرائح من خلال مجموعة ، الا انه يمكنك اضافة الى

(Media Group.) 

 

Media Group 

Task: 

 التي أنشأتها سابقا.لشرائح مقطع فيديو ومقطع صوتي لقم باضافة  
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Two additional tabs will be available when adding a video or an audio: 

Format Tab: 

(، تعديل ابعاد Styles(، تغيير اطار الفيديو وبعض التأثيرات )Adjustعلى ضبط الوان واضاءة الفيديو )يمكنك من التعديل 

 (.Sizeالفيديو )

Playback Tab: 

 ( ليعرض مقطعا محددا.Trim Videoيمكنك من قص الفيديو )

 

Task: 

مقطع الفيديو الذي أدرجته سابقا من خلال  التعديل علىقم ب 

(Format Tab ،)ثم قصه ( من خلالPlayback Tab )

 ثوان. 3ليعرض مقطعا لا يتجاوز 

 

 

 

 

 

 
 

Part IV : Design Tab  

Themes & Background Groups 

 
Create a background of your own by selecting Format 

Background. The Format Background window will appear 

and allow you to select the color, gradient, picture or texture, 

and transparency of the slide background. 

 

 لتلوين خلفيات الشرائح بألوان وأنماط أو صور مختلفة.

 

Task: لون خلفيات الشرائح السابقة كل منها بلون ونمط مختلف 
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Comprehensive Task 

 ( افتح برمجيةPowerPoint وقم بانشاء الشرائح ):التالية 

 اكتب اسمك ومكان السكن. الشريحة الأولى: •

 أسطر في موضوع معين مع وضع صورة وعنوان ملائمين. 3اكتب ما لا يقل عن  الشريحة الثانية: •

 ( مع وضع عنوان ملائم.clipartأدرج ) الشريحة الثالثة: •

 أدرج فيديو وقم بقصه ليعرض مقطعك المفضل مع وضع عنوان. الشريحة الرابعة: •

مع وضع عنوان  موقع الجامعهعند الضغط عليه ينتقل الى ( hyperlink ) ادرج ارتباط شريحة الخامسة:ال •

 .)جامعة البلقاء التطبيقية(

( بعد ايجاد القيم Excelانقل الجدول التالي من )( ثم Students Marksضع عنوان ) الشريحة السادسة: •

 المطلوبة:

Name  Mark 

Jamal 9 

Ali 12 

Saleem 5 

Hani 18 

Kamel 11 
 لعلامات الطلبة.  (max( و )sum( ، )average( ،)minانقل القيم التالية )

انقل الرسم البياني من باستخدام احد الرسوم البيانيه مثل علامات الطلبه في الجدول اعلاه، ثم  الشريحة السابعة: •

(Excelالذي يمثل اسماء الطلاب مع علامتهم الجديدة ) ،عنوان )الرسم البياني( للشريحةضع و. 

 .لون خلفيات الشرائح السابقة كل منها بلون ونمط مختلف 
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Part I : Transitions Tab  

 نتقال الشريحة هو التأثير المرئي الذي يحدث عند الانتقال من شريحة إلى الأخرى أثناء العرض التقديمي. ا

 

Timing Group: 

 

 .التحكم في السرعة وإضافة الصوت وتخصيص مظهر تأثيرات الانتقالتمكنك هذه المجموعة من 

 Task :  الشرائحاختر من حركات انتقال (Transitions) ما يناسب من حركات لجميع الشرائح في ملفك. 
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Part II : Animations Tab 

 

( للكائنات الممثلة Entranceيمكنك اختيار حركات الدخول )

( الممثلة Emphasisبالنجوم الخضراء، وحركات البقاء )

( الممثلة بالنجوم Exitبالنجوم الصفراء، وحركات المغادرة )

 الحمراء.

 
 
 
 
 

 ( حيث تحصل على حركات جديدة للكائنات.More Entrance Effectsأما للمزيد من الحركات يمكنك الضغط على )
 

 

Once the animation has been applied, you can click 

on the Animation Pane tool to customize the 

applied animation in terms of timing, triggers for 

the animation. 

  

Timing Group: 

تمكنك هذه المجموعة من تغيير بدء حركة الكائنات بدلا من الضغط 

على الماوس الى الحركة تلقائيا بعد الكائن السابق او معه، كما تمكنك 

من زيادة مدة الحركة )تبطيء حركة الكائن( او تقليلها )تسريع حركة 

 الكائن(.
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Part III : Slide Show Tab  

Start Slide Show group  

 
 current( أو من الشريحة الحالية )from the beginningهذه المجموعة من عرض الشرائح من البداية )تمكنك 

selected slide). 

Set Up group 

 
( او Hide Slide( او اخفاء شريحة من العرض )Rehearse Timingعمل توقيت للشرائح )تمكنك هذه المجموعة من 

 (.Set Up Slide Showاعدادات اخرى )ٍ

Navigating within your Slide Show 

If you want to..  Press the…  
Display the next slide  () key  

(down  arrow) key  

Enter key  

Space bar key  

Display the previous slide  () key  

(up arrow) key  

Blank the screen  B key  
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Comprehensive Task 

 ( افتح برمجيةPowerPoint:وقم بانشاء الشرائح التالية ) 

 .التخصص الذي تدرسهاكتب اسمك و حة الأولى:الشري •

 مع وضع صورة وعنوان ملائمين. المواد التي تدرسها لهذا الفصل بتعداد نقطياكتب  الشريحة الثانية: •

 أدرج فيديو وقم بقصه ليعرض مقطعك المفضل مع وضع عنوان. :الثالثة الشريحة •

والأخر لعرض صور عن  يتحدث عن تخصصك( احدهما hyperlinks 2ادرج ارتباطين ) :الرابعةالشريحة  •

 .التخصص مع وضع اسم التخصص كعنوان للشريحة داخل شكل بيضوي

يحتوي اسماء موادك لهذا الفصل ( Excelمن ) جدولاانقل ( ثم Mid Marksضع عنوان ) سة:خامالشريحة ال •

 لعلاماتك.  (max( و )sum( ، )average( ،)minمع علامة الامتحان النصفي لكل منها ثم انقل القيم التالية )

 .لون خلفيات الشرائح السابقة كل منها بلون ونمط مختلف 

 .اعمل انتقال للشرائح مختلفا لكل منها 

 لسابقة.اعمل حركة لكل كائن في الشرائح ا 

  اعمل توقيت للشرائح بحيث يتم الانتقال بينها تلقائيا دون الضغط على الماوس كذلك الامر بالنسبه لعرض الفيديو

 وحركات الكائنات.
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Part I : What is a Network? 

A network consists of two or more computers that are linked in order to share programs, resources (such as 

printers), exchange files, or allow electronic communications. The computers on a network may be linked 

through cables, telephone lines, radio waves, satellites, or infrared light beams. 

Common types of networks include: 

 Local Area Network (LAN) 

 Wide Area Network (WAN) 

 Wireless LAN (WLAN) 

 Metropolitan Area Networks (MAN) 

 Wireless WAN (WWAN) 

1.1. Local Area Network 

A Local Area Network (LAN) is a network that is confined to a relatively small area. It is generally limited to a 

geographic area such as a writing lab, school, or building. 

1.2. Wireless Local Area Network 

The term 'wireless network' refers to two or more computers communicating using standard 

network rules or protocols, but without the use of cabling to connect the computers together. 

Instead, the computers use wireless radio signals to send information from one to the other. A 

wireless local area network (WLAN) consists of two key components: 

 A wireless access point (WAP) (also called a Base station)  

 And a wireless card. 

 
 

Wi-Fi is a popular technology that allows an electronic device to exchange data or connect to the internet 

wirelessly using radio waves. 

Many devices can use Wi-Fi, e.g. personal computers, video-game consoles, smartphones, some digital 

cameras, tablet computers and digital audio players. 

1.3. Metropolitan Area Network (MAN) 

A (MAN) is a large computer network that spans a metropolitan area or campus. Its geographic scope falls 

between a WAN and LAN. MANs provide Internet connectivity for LANs in a metropolitan region, and 

connect them to wider area networks like the Internet. 

1.4. Wide Area Network 
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Wide Area Networks (WANs) connect networks in larger geographic areas, such as whole world.  Dedicated 

transoceanic cabling or satellite uplinks may be used to connect this type of global network. 

WANs as computer networking technologies used to transmit data over long distances, and between different 

LANs, MANs and other localized computer networking architectures.  The Internet can be considered a WAN 

as well, and is used by businesses, governments, organizations, and individuals for almost any purpose 

imaginable. 

 1.5. Wireless Wide Area Network 

Wireless WAN is a wide area network in which separate areas of coverage or cells are connected wirelessly to 

provide service to a large geographic area. 

A WWAN often differs from wireless local area network (WLAN) by using mobile telecommunication cellular 

network technologies such as WiMAX (often called a wireless metropolitan area network or WMAN) and 

cellular digital packet data (CDPD) to transfer data. 

These technologies are offered regionally, nationwide, or even globally and are provided by a Wireless Service 

Provider for example Zain, Orange and Umniah in Jordan.  

Part II : Network Drawback (Computer Viruses) 
 

Computer Viruses are the most network drawback. Viruses are becoming more and more 

sophisticated and employ many different methods of spreading. While email has been the 

primary method for the spread of these recent computer viruses, it is not the only method.  

A computer virus can enter a network by CD, floppy disk, internet download, file 

transfer and file sharing programs, or by remote users connecting directly to the corporate network with an 

infected PC. Once computer viruses gets into a network it can spread to computer in multiple ways.  

2.1. Common Types of Computer Viruses 

 A macro virus is associated with application software like word and excel. When opening the infected 

document, macro virus is loaded into main memory and destroys the data stored in hard disk  

 A worm is also a destructive program that fills a computer system with self-replicating information, 

clogging the system so that its operations are slowed down or stopped  

  A time bomb is a virus program that performs an activity on a particular date  

 Trojan horse is a destructive program. It usually pretends as computer games or application software. If 

executed, computer system will be damaged. 

 2.2. Antivirus software 

The Antivirus software protects the computer from computer viruses. The following figure represents the 

common types. 
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2.3. Preventing from virus infection 

 Always update your anti-virus software at least weekly. 

 Get trained on your computer's anti-virus software and use it. 

 Have multiple backups of important files. This lowers the chance that all are infected. 

 Forget opening unexpected e-mail attachments, even if they're from friends. 

 Scan internet downloads. 

 Use firewall to protect your computer and network. 

Part III : Internet Overview 
 

3.1. What is the Internet? 

 The Internet (also known as the Net) is a world-wide electronic network that enables many independent 

computer networks to connect together by using a common connection, called an Internet Protocol (IP) which 

will dynamically and intelligently figure out a way to get data from one point to another across multiple ISPs. 

 3.2. How do I access the Internet? 

A computer is “hooked up” to the Internet when the owner subscribes to an Internet Service Provider (ISP) 

and has a browser installed on to the computer.  An ISP is a company that will allow you to use their computer 

connections to access the Internet for a fee.  

To be able to access all the internet has to offer: 

1. You will need an internet account with an internet service provider (ISP). ISPs like Orange provide these 

accounts usually for a monthly fee, much like a phone service. You might also need to have somebody come and 

install a line into your home. 

2. You will also need what’s called a modem (or modem router). Your ISP will be able to sell you a modem when 

you set up an account with them. 

3. Once you have an account and a modem set up (the ISP will guide you through setting up the modem), you just 

have to plug your computer into the modem to access the internet. 
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There are a number of different ways to access the internet. There are five major types of internet access: 

1. Old fashioned dial-up. You can’t make or receive phone calls while connected via dial-up to the 

internet. 

2. ADSL, which uses a special modem to transform your existing phone line into a high-speed phone line. 

Because it is a broadband connection, you can chat on the phone at the same time you use the internet. 

ADSL is the most common type of broadband connection and the easiest to set up at home. Most ADSL 

services require that you have a phone service, but there are also so-called ‘naked’ DSL services that 

require no phone service. 

3. 3G/4G which uses mobile phone networks to connect you to the internet. 

4. Satellite, which transmits data from satellites. 

Not all services are available in all areas. Your ISP will tell you which ones are available to you. While different 

internet connection services have strengths and weaknesses, they all connect you to the same internet. 

3.3. Different Speeds and Quotas 

When signing up for an internet account, you may be dazzled by the number of different and confusing options 

available.  

There are different speeds and different monthly quotas available on different accounts. 

 Speeds are measured in kilobits per second (Kbps) or megabits per second (Mbps), with 1mbps equal to 

1000kbps. A dial-up connection works at 56Kbps, while ADSL can go as fast as 24Mbps – more than 

400 times faster than dial-up. 

 The monthly download quota determines the volume of data and media you can download before your 

ISP either cuts you off, slows down your connection or charges you extra (depending on the specifics of 

your internet account agreement). 

 Volumes are measured in gigabytes (GB) and sometimes megabytes (MB), where one GB is equal to 

1000MB. You’re not likely to go over your limit just looking at web pages and sending emails, but if 

you watch a lot of online videos you might reach your monthly limit. 

Part IV : The Internet and Everyday Life 
 

New uses for the internet are being invented every day. There are literally hundreds of millions of web pages 

and services available. It’s very easy to sink hours, days, weeks and months exploring all the internet has to 

offer. 

The following uses are the most common: 

1. Sending emails, which are letters that can be sent for free to anyone and arrive instantly. 

2. Looking up news, weather, health information and sports results, government information and forms. 

3. Searching for information on just about any topic, such as Flight timetables, phone numbers and just 

about anything else you can think of! 

4. Doing all your banking, taxes and business online. 

5. Sharing your photo and video collection, and seeing the shared collections of others. 
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6. Talking or video chatting with online friends – at any time, for free. 

7. Participating in discussions on topics you find interesting, with people from around the world. 

8. Downloading and watching movies, reading book reviews or watching sports. 

9. E-commerce, buying and selling goods from online stores. 

Part V : The Browser 
 

An Internet browser is a computer application that will give you access to the Internet and navigate the World 

Wide Web. 

  

The World Wide Web (WWW), also known as the Web, is made up of millions of documents called web 

pages. Web pages can include text, pictures, video and sound. Most organizations on the Web have sets of 

pages, which are linked together. These sets of pages are called websites. You can use the Web to get up-to-

date information about almost any subject. 

 

5.1. Internet browsers Examples 

 

 

 Each of these Internet browsers will interpret the computer code in web sites, in order to display text and 

graphics (on these sites), provide encryption security, play video and music, and display links to other web 

pages. 

5.2. Website Address 

A domain name is the root web address for a Website. Domain names function on the Internet in a manner 

similar to a physical address in the physical world. Each part of the domain name provides specific information. 

These pieces of information enable web browsers to locate the web page. The naming system is closely 

regulated in order to prevent confusion or duplicate addresses.  

 An Internet address is in alphabetic form. Domain names must have at least two parts:  

 the part on the left which names the organization (website name), 

 And the part on the right which identifies the highest subdomain (extension), such as the country or the 

type of organization. 
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"bau.edu.jo" bau is the organization and edu.jo identifies it as an educational institution in the Jordan. There 

are only a limited number of such highest subdomains. For example: 

 

 

 

 

Part VI : Internet Explorer Browser 
 

First, you need to open the web browser. That means clicking the Internet Explorer icon. When the program 

starts, it will automatically go to a home page. It is a web page that is configured to be displayed first when a 

Web browser is opened. 

 

 

 

 

 

 

 

 

 

 

 

When the browser opens, you’ll see buttons, icons and headings representing various features, tools, search and 

navigation controls. From left to right: 

subdomain name usual meaning 

.ac university etc in UK 

.co business in UK 

.com commercial business 

.edu Educational institutions 

.gov Government site anywhere 

.org Organizations (nonprofit) 

 

1. Back: Go back to a previously viewed web page.  

2. Forward: Go forward to a previously viewed web page. 
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Part VII : Changing Your Home Page 
 

Home page is the page that the browser opens to whenever you start it up. To change your Home page.  

 

Address bar: Enter a website address or a search term here to find what you’re looking for. It 

is also called as Uniform Resource Locator (URL). 

 

 

1. Search engine selector: Click the adjacent down-arrow to choose    preferred search 

engine (google, bing, yahoo) 

2. The AutoComplete feature in Internet Explorer lets you more quickly fill out web forms 

and go to websites you have visited in the past. 

3.  Security report: clicking this icon displays a report describing the certificate used to 

encrypt the connection and the certifying authority that issued the certificate. The security 

report also provides links to more detailed information. 

4. Refresh: Reloads web page, so you know you’re looking at the most current version. 

 

 

Tab: Shows the title of the website in the open window. 

 

 

Click on that icon a new tab will appear. You can go to any address you like in this new tab.  

 

1. Home: Reverts to web browser’s home page, the one you see when you first start Internet 

Explorer.  

2. Favorites: Displays websites saved as favorites. When you click on Add to Favorites. The 

current web page will now be added to your Favorites list. Whenever you click on Favorites 

again, you will see it.   

3. Tools: Access zoom, print, internet options and other functions.  

 

 

Menu bar: can be turned on or off in Windows Internet Explorer. That is representing various 

features and functions. 

 

 

 

Favorites bar: that enables one-click access to your favorite web sites. 

 

 

Command bar: offers easy access to almost any setting or feature in Internet Explorer. You 

can customize the Command bar buttons to suit your preferences. 

 

 

Status bar: it displays messages such as a webpage's download progress. 
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1. First you go to the web page that you’d like to set as your home.  

2. Now right-click on the Home button. A drop-down menu will 

appear. 
 

3. Move your mouse to Add or Change Home Page and left-

click. 

a. Select Use this Web Page as Your Only Home Page. 

b. You can have several pages as your home page; with each 

page open in its own tab. Select Add this Webpage to 

your Home Page Tabs. 
 

 

 

Part VIII : Search Engine 
 

A search engine is a website that you can use to look up web pages. 

There are many different types of search engines made by different companies, the most popular ones are: 

 www.bing.com Bing is Microsoft’s alternative to Google. 

 www.google.comThe home page of Google, the world’s largest search provider. 

 www.yahoo.com 

But the most popular is Google. To search the internet with Google, type www.google.com into the Address bar 

of your web browser. 

 

 

The Google main page will appear. In the middle of the page is the Google Search bar. 
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How to read search results 

Google's goal is to provide you with results that are clear and easy to read. The diagram below points out four 

features that are important to understanding the search results page.  

 

 

 

 

 

 

 

 

 

 

 

 

1. The title: The first line of any search result is the title of the webpage.  

2. The snippet: A description of or an excerpt from the webpage.  

3. The URL: The webpage's address.  

4. Cached link: A link to an earlier version of this page. Click here if the page you wanted isn't available. 

Part IX : Saving or Copying images 
 

1. Select the image  right click and then choose either: 

Copy then paste it in the desired place. 

or  

Save Picture as then save it in the desired location so you can find it later.  

 

 

 

 

 

 

Part X : Saving a web page 

Choose File > Save As menu item. In the dialog box that opens, you have several file types option. Select your 

option for saving the page as a different file-type. 
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Part XI : Sign up using Yahoo Mail 

 

To create an email account in Yahoo mail: 

1. Go to this link, mail.yahoo.com. Or go to Yahoo website (www.yahoo.com). Then click on Mail icon, Fill 

in the required fields and read on the terms and agreements. After accepting all the terms 

and agreements you will automatically be able to open your Yahoo account. 

 

2. Click on Create New Account button to start. 

 

3. The Sign up window will appear. Fill in the required fields and read on the 

terms and agreements.  

 

 

 

 

 

 

 

 

4. After entering your information click on 

Create account button. 

 

 

 

5. After accepting all the terms and agreements 

you will automatically be able to open your 

Yahoo account. 
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Appendix: Social media networks 
1) Facebook 

 

 

 

 

 

 

 

 

 

 

2) Twitter 
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